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BIBLIO MENU

This menu contains options for creating formatted outputs for bibliographies.

 

can a Document for Citations…

Before the scan

Scan a Document for Citations searches a TEXT, RTF, MIF (FrameMaker) or WordPerfect 2 or 3
document for reference citations (RTF files, sometimes referred to as Rich Text Format or 
Interchange Format, are specially saved files from Microsoft Word, versions 3 and later, 
WriteNow, MacWrite, and others). In Word, you save an RTF file by choosing Save As and then 
selecting Interchange Format (RTF) [Word 5] or    Rich Text Format [Word 6].

For Bookends, a citation consists of identifying information about a reference that is typed into a 
manuscript between two curly brackets, or braces — ‘‘ and ‘’. This is referred to as citation by 
content. The most reliable way to do this is with the Copy Citation button in each reference 
window or the Copy Selected button in the Hits Window. This ensures that the citation is 
unambiguous (unique). However, you may elect to type in the citation yourself, without using 
Copy Citation or Copy Selected. This means that you can insert citations into your manuscript 
without having to refer to the Bookends database! Any text in the reference can be used to 
specify the citation: an author’s name, the date, a few words from the title, the journal, etc.

Bookends tries to find every item in the citation with four exceptions:

            1. _and_
            2. _et al
            3. _et al.
            4. _&_



where “_” represents a space. Therefore, if you cite

            Bracken et al., 1985
or
            Punch & Judy
or
            Wilberry and Schwartz, 1976

Bookends still finds the references, even though the exact words “Bracken et al., 1985”, “Punch 
& Judy”, and “Wilberry and Schwartz, 1976” never appear in the references.

You can also use the relative reference number to identify a citation. If the first character in the 
citation is a number, Bookends assumes it is the number of the reference you want to cite, and 
will ignore any text after it until the end of the citation entry.

Citations by content and citations by number can be mixed in a single set of curly brackets! For 
example,

            Smith and Jones, 1993, export law; 45; 22; Terry et al., 1988

will find four hits, the first and last identified by content, and reference 45 and 22, identified by 
number.

+
There can be problems when scanning RTF documents and retaining citations as
            hidden text if a citation’s open or close curly bracket (brace) has a font, size, or style
            that is different from characters in the citation itself. This can cause incorrect
            formatting instructions to be retained in the RTF file, resulting in erroneous
            truncation of the document when it is opened by a word processor. To avoid this,
            make sure that a citation’s bounding curly brackets have the same font, size, and
            style as the characters in the citation.

Creating removable in-text citations
There are instances in which you may need to enter an in-text citation to ensure that the reference
is placed in the bibliography, but do not want a citation to appear in the final, revised document. 
To do this, enter an exclamation point (!) immediately after the open curly bracket of the citation.
When Bookends encounters the in-text citation, it will look up the reference and place it in the 
Hits List for producing the bibliography. If you are creating a revised document Bookends will 
remove the curly brackets and any information between them from the revised document. For 
example,

            
As shown by Reginald (1996) !Reginald, J. Polygons, 82, 1996, squares
            represent a subset of rectangles.



would appear in the revised document as

            
As shown by Reginald (1996), squares represent a subset of rectangles.

The Scan a Document... Dialog

When you choose to Scan a document for citations, Bookends asks you to choose a Text, RTF, 
MIF, or WordPerfect version 2 or 3 file and then displays the following dialog (NOTE: in this 
example, an RTF file was selected)

 

he options are:

Generate a bibliography after scan—If checked, Bookends will automatically
generate a bibliography after scanning a manuscript to find citations.

Scan using the bib/document format of…—A pop-up menu from which you can select the 
Format for the bibliography and the in-text citations.



+
Only the Formats that are included in the database are listed. To use other Formats
            that are in the Format Bank, you must first transfer them to your Bookends
            database.

Send the bibliography to—If a bibliography is generated, it will be saved to the selected 
destination: Bibliography Window or Disk.

Generate bibliography—If a bibliography is generated, it will be created either with (With styles)
or without (Without styles) styled text (bold, italics, underline, alternate fonts such as Symbol 
(Greek), etc.), depending on which is selected in the Bibliography Formatter.

Create new Text/RTF/WordPerfect File—This option lets you create a copy of the manuscript in 
which the citations in curly brackets (e.g. Smith et al., 1989) have been replaced with the 
appropriate in-text bibliography notations (e.g. (1, 4)). These are defined with each Format. The 
type of file created (Text, RTF, or WordPerfect) will be identical to the type of file being 
scanned.

The default setting of this button is in Preferences.

Retain citations as hidden text (RTF only)—If this option is selected, Bookends will not discard 
citation information (between the curly brackets) when it replaces that information during a scan 
of an RTF document. Rather, the original citation entries will be retained in the revised 
manuscript as hidden text. Word processors that accept hidden text (such as Microsoft Word) will
not print the hidden text when the rest of the manuscript is printed. The information is there, 
however, and can be recovered by selecting the ‘Restore (Unscan) an RTF document..’ item in 
the Bookends menu.

The default setting of this button is in Preferences.

Do bibliography and/or custom citations as HTML—When this box is checked, Bookends will 
add HTML-encoding information to the bibliography you create and/or the custom citation that 
is used in the revised document (if one is specified in the definition of the Format used for the 
scan). Bookends will automatically add <HTML> to the beginning of the revised document and 
</HTML> at the end of the revised document. If the document you are scanning already has 
these tags (i.e. is already HTML-encoded), Bookends will not add these tags.

+
This option is enabled only if you are scanning a text (ASCII) file.

Proofreading scan—This option creates a copy of the original document in which the curly 
brackets (braces) are left in. It is useful for those who enter citations in manuscripts without 



using the Copy Citation feature (i.e. type them in themselves). In this situation it is possible to 
have ambiguous entries, such as “Carpenter, 1990”, and have more than one reference in the 
database written in 1990 and having an author named Carpenter. If Bookends finds more than 
one possible hit while scanning the database, it will put up a dialog listing the possible hits and 
ask you to choose the one you intended (see below). During a Proofreading scan, after Bookends 
asks for the intended reference it will replace the initial citation with a correct and unambiguous 
citation (e.g. Carpenter et al., J. Biol. Chem., 12323-12330, 1990). This “proof-read” copy can 
subsequently be used, and when scanned again there will be no unambiguous citations. If you 
have elected to have unique reference IDs used with Copy Citation they will also be inserted in 
the document during the Proofreading scan. This option can be reached by selecting pg. 2 of 
Preferences Utilities menu).

During the scan

As Bookends “reads” your manuscript, a dialog will show you the citations by content as they 
are encountered. Citations by number are not shown. Note that with Multifinder or System 7 the 
scan can work in the background, allowing you to work in another application while the Scan is 
in progress.

For example, the following citation might be found:

            …as previously shown Brown, 1993…

When Bookends encounters this sentence, it searches the database for any reference with Brown 
anywhere in the list of authors and written in 1993 (actually, Bookends searches every field for 
these words, so if a reference had the word “Brown” in the Title and the date “1993” in the 
Abstract, it would qualify as a hit).

If just one reference includes both “Brown” and “1993”, the number of the reference is placed at 
the end of the list in the Choices field of the Choose Window. If multiple references include 
“Brown” and “1993” (i.e., this is an ambiguous citation), Bookends puts up the dialog box:

 



he scrolling list contains the relative number of each matching reference, its first author, title, 
journal, and date.

There are four options:

Go Ref (or double-clicking on a reference): displays the selected reference.
This One: (or pressing Return) chooses the selected reference and the Scan continues.
None of these: the Scan will continue, and at the end Bookends will notify you that this citation 
was not found in the database. 
Stop: aborts the Scan.

+
Since this is a movable dialog box, you can see the underlying reference to verify
            whether it is the one you intended or not.

If no match is found, when the Scan is complete, it (along with all other unmatched citation 
entries) are displayed in a floating window:

 

his list can be printed or saved to a file, or you can click on Find (double-clicking on an entry 
invokes Find). In this case, punctuation, “and”’s, and “et al.”’s are stripped from the highlighted 
entry and it is placed in the Find dialog. You may be able to find the correct entry in the database 
by editing the text in the dialog and doing a Find.

You must deal with the unmatched citations (by printing, saving, or Finding) before closing this 
floating window. Once it has been closed, the list of unmatched citations cannot be recalled.

Replacing citations with numbers
If you are creating a new document in which citations are to be replaced by numbers, citations 
that are replaced by three or more sequential numbers will be substituted with a hyphenated 
range. For example, in a revised manuscript: 

                (1, 3, 4, 5, 6, 9, 11, 12, 13) will be converted to (1, 3-6, 9, 11-13).



Handling “out of range” citations by number
If a reference in a document is cited by number (i.e. 342), Bookends will test to see if that 
reference exists. If it does not, Bookends will alert you after the scan by including the number 
and the words “[out of range]” in the floating window that lists unmatched citations.

+
This problem (citation numbers out of range) usually occurs when you inadvertently
            cite a reference by its unique ID without preceding it with the ‘#’ symbol, or the first
            item in a cited reference is its year of publication (remember, if the first character of a
            citation is a number, Bookends assumes the number refers to the number of the
            reference in the database).

Dealing with “smart” apostrophes
Any "smart" apostrophes in an in-text citation are replaced with a standard apostrophe when a 
document is scanned. Smart apostrophes are:    ‘        and        ’      . Use standard apostrophes (') in 
your references (this is the apostrophe character that you normally type in directly from the 
keyboard).

After the scan

After Scanning a Document, one of several things may happen:

If the bibliography is sent to the Bibliography Window and a (revised) copy was made of the 
original document, Bookends will automatically copy it to the clipboard and prompt “Open the 
revised manuscript in your word processor?”. If this is accepted, Bookends will launch the word 
processor specified by the user (in Preferences) and open the revised manuscript. The user need 
only scroll to the desired location and Paste to place the finished bibliography in the document. If
older versions of Microsoft Word (≤ 4) and WordPerfect (≤ 2.0) are already open, Bookends will 
switch to them but will not open the revised document automatically —the user must do this via 
the Open command in the File menu. Microsoft Word 5 or later and WordPerfect 2.1 or later 
work properly in this situation.

If the bibliography was sent to disk and the original document revised, Bookends will offer to 
“Open the revised manuscript in your word processor?” without first copying the bibliography to
the clipboard (it’s in a file on the disk). Once in your word processor, you must open the 
bibliography file on the disk using the Open command in the File menu.

+
The citations that were found during the scan can be found in the Choices field
            (Choose window). The list will remain there until replaced. This means that if you
            want to generate the bibliography again (because you detected a mistake in the
            Format, for example) you can do so without Scanning again. Just go to the Choose
            window, click on Get Choices, go the the Bibliography Formatter, and click on
            Make Bib.



The Choices list of matching references can also be saved in one of the Storage fields.

+
FrameMaker does not recognize MIF styled text information in the clipboard.
            Therefore, if you copy and paste a bibliography from the Bibliography Window to a
            FrameMaker document, you will lose styling information. To place a bibliography
            with styled text in a FrameMaker document, save the bibliography to disk with
            styles and open the resulting file in FrameMaker.

Rules for scanning

Here are some rules you should keep in mind when preparing a document you plan to use with 
Scan a document for citations:

•
Always place citations between curly brackets.
•
Multiple reference citations must be separated by a semicolon ( ; ), a slash ( / ), or an
            asterisk ( * ) [you can select which of these you prefer in Preferences]. For example,

                        ..and because the sky is blue Henry, 1875; Schmitt-Verhulst, 1905; Castel,
                        1910...

•
Multiple items within a citation (such as “author, date”) should be separated by
            commas for clarity—Bookends removes these before looking through the database.

•
Citation by content doesn’t just work for names and dates. Any data that is in the
            reference can be searched for, including words from the Title, Keywords, etc. The
            only rules are that the collection of words that define one citation must be separated
            by a semicolon, slash, or asterisk from other citations in the same set of curly
            brackets, and all citation entries must be enclosed in curly brackets.

•
Use the Copy Citation button (located in the reference display) or the Copy Selected
            button (in the Hits Window) when possible, because they will always provide a
            unique, unambiguous citation.

Restore (Unscan) an RTF Document…

When an RTF document is scanned, you have the option of retaining citations (the information 
between curly brackets) as hidden text in the revised manuscript. Word processors that accept 



hidden text (such as Microsoft Word) will not print the hidden text when the rest of the 
manuscript is printed. The information is there, however, and can be recovered by selecting the 
‘Restore (Unscan) an RTF document..’ item in the Bookends menu. When Bookends restores an 
RTF document to its original form, the hidden citations are revealed and the citation entries 
placed in the document by Bookends are removed (that is, it puts back citations in curly brackets 
and removes reference entries (numbers, or names-and-date) placed in the document by 
Bookends Plus). The restored manuscript can then be edited and/or re-scanned to generate a 
bibliography. This is useful if you want to re-scan a manuscript that was edited after being 
scanned by Bookends.

The option of retaining citations as hidden text is offered in the “Scan a document” dialog box 
that appears after you have selected an RTF file to scan. The default setting for this option is set 
in Preferences.

+
Showing the hidden citations in the revised document will result in a confusing
            display. It is advisable to turn off this display in your word processor by not
            showing hidden text. This can be done in Microsoft Word 5 by toggling the ‘Show
            Hidden Text’ item in the View menu OFF. If this option is not visible in your View
            menu, add it by using the Command menu item in the Tools menu. If you are unsure
            of how to add menu items in Microsoft Word, consult the documentation.

Make sure you always ‘restore’ an RTF document with hidden text before you re-scan it. If you 
do not, the resulting revised document will contain inaccurate citations.

+
This feature is meant to be used only in case the original version of the document
            (with the curly brackets in place) is not available. Since the citation information is
            retained as hidden text, it is possible to inadvertently delete some of the embedded
            information that Bookends requires to properly restore the citations. For that reason,
            it is safest to modify the original document and re-scan it if necessary, rather than
            modify the scanned document and then rely on Bookends to restore it to its original
            state.

Because WordPerfect does not recognize hidden text, it is not possible to restore (unscan) a 
WordPerfect document, even if it had been saved as RTF and then opened by WordPerfect.


